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Overview
The following is a description of the data creation and assignment process.  Since
NCSA Mesher is designed to be completely independent of the computational code
being used, the data types are not built into the program.  Therefore, data handling
is accomplished in two separate steps.  

First, the data types are defined and formatted into dialog boxes.  When they are
defined,  the data types are  also given default  values.  This  is  done in  a utility
program called DBuilder.   Data type definition need only be done once for each
computational program.  

Second, the data values are actually input and assigned to specific cells of a grid.
This is accomplished in NCSA Mesher.

DBuilder
DBuilder is a utility program which comes as part of the NCSA Mesher package.
Each computational program typically requires its own unique set of data types.
DBuilder provides the user with a method of defining the types and formatting them
within dialog boxes.  The data types take the form of alpha-numeric text, numeric,
push buttons, radio buttons,  and checkboxes.  Once defined, the dialogs are saved
as an Attribute Set which can be accessed by NCSA Mesher or DBuilder.

Start Up
To start working with DBuilder, launch it from the finder by double-clicking on the
application icon.  

Menus
At startup time, the DBuilder menu bar contains the three options File, Edit, and
SubDialog.  

Figure 4.1
DBuilder Menu Bar

File Menu
The File menu contains the standard file menu options of New, Open, Close, Save,
and Quit.

Figure 4.2
File Menu

New The New option from the File menu creates a new document (also
called an Attribute Set).   The document appears as an empty
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dialog box.
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Open The  Open  option  from  the  File  menu  allows  you  to  open  an
existing DBuilder document.  You are presented with the standard
Macintosh file dialog from which to choose your desired file.

Close The  Close  option  from the  File  menu  closes  and  releases  the
document.

Save The Save option from the File menu saves the document to a file.

Quit The Quit option exits DBuilder and returns you to the Finder.

Edit Menu
The Edit menu contains the standard edit menu options of Undo, Cut, Copy, Paste,
Clear, Select All, and Show Clipboard.

Figure 4.3
Edit Menu

Undo The  Undo  option  allows  you  undo  your  last  command.   For
example, if the last command was a cut, the Undo option will say
Undo Cut Control.  When selected, the cut will reappear as if it
had never been removed.

Cut The Cut option allows you to remove the selected data item from
the  dialog  box.   This  item  is  stored  on  the  clipboard  and  is
available  for  pasting.   Cut  is  dimmed  when  no  data  item  is
selected.
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Copy The Copy option allows you to make a copy of the selected data
item on the clipboard.  This copy can be added to a dialog using
the Paste option in the Edit menu.  Copy is dimmed when no data
item is selected.

Paste The Paste option allows you to paste the item currently residing
on the clipboard into the current dialog box.  Paste is dimmed
when no data item exists on the clipboard.

Clear The Clear option deletes the selected data item without placing it
on  the  clipboard.   A  data  item which  is  cleared  can  only  be
retrieved with an Undo command.  Clear is dimmed when no data
item is selected.

Select All  Not available in this version.

Show Clipboard Not available in this version.

Input Types Menu
The Input Types menu appears when a document has been opened or created.  It
presents  you with  a  set  of  control  options  named Alpha,  Numeric,  Button-Push,
Button-Radio, and Checkbox.

Figure 4.4
Input Types Menu

The items in the Input Types menu are basic Macintosh dialog controls.  A data type
is composed of a control and the various information about the data itself, such as
name, maximum or minimum size, default value, etc.  The information required for a
data type varies according to the type of control you choose.  See Data Types later
in this chapter for more information about the controls. 
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SubDialogs Menu
The  SubDialogs  menu  provides  you  with  the  tools  to  manage  the  subdialogs
attached to various data items.

Figure 4.5
Subdialogs Menu

New New creates a new subdialog box and links it  to the currently
selected data item.  A data item with a subdialog has an ellipsis
(three red dots) located to the bottom right of the name.

Open Open displays the subdialog linked to the currently selected data
item.    The subdialog can also be opened by clicking on the
ellipsis.

Close Close hides the subdialog.

Delete Delete unlinks the subdialog and releases the data items within
it.  

DBuilder View 
The DBuilder View is made up of several components.  The first line provides you
with  status  information  about  your  data  item,  current  operation,  and  error
messages.

Figure 4.6
DBuilder View
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X and Y Boxes As a data item is placed or moved, the Horizontal and Vertical
position is shown in the X and Y boxes respectively.  

Message Line This details the current operation or errors.  

Resize Control This is a standard Macintosh resize window control.   Click on the
box in the lower right corner, hold down the mouse button, and
move the cursor to change the frame size.

Data Item
The anatomy of a Data Item is shown in Figure 4.6.  It contains the options Control,
Name, and Resize Knob.

Figure 4.7
Data Item Anatomy

Control

Name

Resize Knob

To create a new data item: 

1. Select  the  control  type  from the  Input  Types  menu.   Choose  from Alpha,
Numeric, Button-Push, Button-Radio, and Checkbox.

2. A hand appears, allowing you to drag the outline of the data item (see Figure
4.7).

3. Move the hand to the desired location.
4. Press the mouse button to release the data item (see Figure 4.8).

Figure 4.8
Placing a Data Item

Figure 4.9
Dropping the Data Item
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Resize Item
To resize the data item, place the cursor over the Resize Knob.  The cursor will
change shape, becoming a crossbox, as shown in Figure 4.9.

Figure 4.10
Resize the Data Item

To resize a data item: 

1. Place the cursor over the Resize Knob.
2. Press the mouse button and hold it down.
3. Move the mouse.  The outline box for the data item will change size as the

mouse moves.
4. Release the mouse button when the box is the desired size.

Move Item
To move the data item, place the cursor over the control.  The cursor will change
shape, becoming a hand, as shown in Figure 4.8.

To move a data item with the mouse: 

1. Place the cursor over the control.
2. Press the mouse button and hold it down.
3. Move the mouse.  The outline box for the data item will move as the mouse

moves.
4. Release the mouse button when the box reaches the desired location.

To move a data item with the keyboard: 

1. Double-click on the control to open the data item edit dialog.
2. In the edit dialog, find the box titled Location containing a field for X and a

field for Y.
3. Enter the appropriate values in the X  and Y fields.
4. Press Set to move the item (the Set button is dimmed until a new value is

entered in either the X or the Y fields).
5. To cancel the move and reset the X and Y values, press Cancel.
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Adding a Subdialog
Data items can have subdialog boxes attached to them.  An attached subdialog is
denoted by an ellipsis (three red dots) to the right of the data item. 
To add a subdialog to a data item:

1. Select  the  desired  data  item by  clicking  on  the  item (the  data  item will
become highlighted with a bounding box).

2. Choose New from the Subdialogs menu (an ellipsis will be attached to the
right of the data item).

Subdialogs allow you to design a flexible hierarchical  data set.   For example, at
dialog level 1 you may create a checkbox data item for metal types.  At level 2, the
dialog may contain a radio cluster with a number of metals, such as gold, silver,
copper, and iron.  The window title for a subdialog is the same as a prompt of the
item to which it is attached (see Figure 4.10).

Figure 4.11
Subdialogs

Opening a Subdialog
A subdialog box may be opened either using the menu or the ellipsis.

To open a subdialog using the menu:

1. Select  the  desired  data  item by  clicking  on  the  item (the  data  item will
become highlighted with a bounding box).

2. Choose Open from the Subdialogs menu (the subdialog will  appear on the
screen or be brought forward if it is already shown).

To open a subdialog using the ellipsis:

1. Select  the  desired  data  item by  clicking  on  the  item (the  data  item will
become highlighted with a bounding box).

2. Click on the attached ellipsis (the subdialog will appear on the screen or be
brought forward if it is already shown).
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Data Types
Alpha-Numeric

For data fields where text is required as input, the Alpha-Numeric data item is used.
To create a new Alpha-Numeric item, select Alpha from the Input Types menu.  The
three parts of an Alpha-Numeric item are the item prompt (shown as Alpha Text in
Figure 4.11),  the field (the blank box to the right of Alpha Text in Figure 4.11), and
the resize knob (the small black box off the lower right corner of the field).  The item
is edited by double-clicking on the item prompt.  Then the dialog box shown in
Figure 4.12 appears.

Figure 4.12
Alpha-Numeric  Anatomy

Figure 4.13
Alpha-Numeric  Edit Dialog

Prompt This is the title displayed to the left of the field box.  Change the
prompt  by  highlighting  the  text  currently  in  the  field  box  and
entering new text.
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Defaults The default is the recommended value currently displayed.  To
enter a different value, use the mouse to place the cursor in the
field box and enter the text.

Location This the current X/Y coordinates of the Alpha-Numeric data item
in the DBuilder View.  The Set button is dimmed until a new value
is entered in either the X or the Y coordinate fields.  To move the
data item, enter a new value in the X/Y fields and press the Set
button.  Pressing the Cancel button reverts the X/Y fields back to
their original values.

Data Location The  two  parts  to  the  data  location  information  are  the
fixed/justified  radio  buttons  and  the  X/Y  coordinates.    Both
calculate the size of the Title Space (see Figure 4.13), which is the
amount of space between the left edge of the box and the left
edge of the data field.  If the Title Space is not wide enough to
display the whole title, the title will wrap to the next line. 

Fixed/Justified:  Setting  the radio button on Fixed forces the
title space to be a specific size.  Setting it on Justified adjusts the
size  of  the  Title  Space  according  to  the  length  of  the  title.
Justified is the default for an Alpha-Numeric data item.  

X/Y:  The X/Y coordinates are only necessary for a fixed size Title
Space.  The X/Y are the coordinates for the upper left corner of
the data field box.  To change the width of the Title Space, edit
the X coordinate to move the left edge of the data field, thereby
making the data field smaller.  The Set and Cancel buttons inside
the  Data  Location  box  activate  the  changes  to  the  X/Y
coordinates.

Figure 4.14
Title Space

Title Space Data Field
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Numeric
For data fields where a numeric value is required as input, the Numeric data item is
used.    To  create  a  numeric  item,  select  Numeric  from the  Input  Types  menu.
Numeric  data  items  function  similar  to  Alpha-Numeric  data  items  (see  Alpha-
Numeric for more information).  The three parts of a Numeric item are the item
prompt (shown as Numeric Text in Figure 4.14),  the field (the blank box to the right
of Alpha Text in Figure 4.14), and the resize knob (the small black box off the lower
right corner of the field).  The item is edited by double-clicking on the item prompt.
Then the dialog box shown in Figure 4.15 appears.  

Figure 4.15
Numeric  Anatomy

Figure 4.16
Numeric  Edit Dialog

The fields in the Numeric Edit Dialog are the same as in the Alpha-Numeric Edit
Dialog with a few exceptions.  Those that differ will be discussed below.  For further
information on the fields which are similar, see the discussion on the Alpha-Numeric
Edit Dialog.

Defaults This is the recommended value currently displayed.  To enter a
value, use the mouse to place the cursor in the box and enter the
new number.   The fields for  Minimum, Maximum, Integer,  and
Real are enforced in the Defaults entry field.

Minimum This is the smallest number that can be entered in this data item.
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Maximum This is the largest number that can be entered in this data item.

Integer / Real The data item can be defined as an integer or a real number.  The
default state is Integer.  To change the state, use the mouse to
click on the desired radio button.

Checkbox
For data fields where an on/off value is required as input, the Checkbox data item
should be used.  To create a new Checkbox, select Checkbox from the Input Types
menu.

The parts of a Checkbox data item are the item prompt (listed as Checkbox in Figure
4.16), the control (the square button to the left of Checkbox), and the resize knob
(the small black box in the lower right corner).  The item can be edited by double-
clicking on the control.  The dialog box shown in Figure 4.17  then appears.

Figure 4.17
Checkbox  Anatomy

Figure 4.18
Checkbox  Edit Dialog

Prompt This is the title displayed to the right of the control.   Change the
prompt by highlighting the text currently in the box and entering
new text.
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Defaults This is the recommended value that is currently displayed.   The
Defaults button is a toggle.  Click once to turn Defaults on, and
click again to turn Defaults off.  The Off/On status of Defaults is
shown by the location of a dot and the presence of an X in the
Defaults button.  When Defaults is set to Off, a dot is displayed to
the left of the Off field and the Defaults button is empty (as it is in
Figure 4.17).  When Defaults is set to On, the dot is displayed to
the left of the On field and an X is placed in the Defaults button
(as it is in Figure 4.18).  

Figure 4.19
Checkbox  Defaults

Off/On The numeric value assigned to a cell is defined by the on and off
fields.   When you assign this data item to a cell and set it to Off,
the value in the Off box is added to the cell. Conversely, when
you assign this data item to a cell and set it to On, the value in
the On box is added to the cell. 

Location This the current X/Y coordinates of the Checkbox data item in the
DBuilder View.  The Set button is dimmed until a new value is
entered in either the X or the Y coordinate fields.  To move the
data item, enter a new value in the X/Y fields and press the Set
button.  Pressing the Cancel button reverts the X/Y fields back to
their original values.

Push Button
For data fields where an on/off value is required as input, the Push Button data item
is  used.   Push  Button  data  items function  similar  to  Checkbox  data  items (see
Checkbox  for  more  information).   The  primary  difference  between  them is  the
appearance.  To create a new Push Button, select Button - Push from the Input Types
menu.  The three parts of an Push Button item are the item prompt (shown as Push
in Figure 4.19), the control (the square button to the left of Push in Figure 4.19), and
the resize knob (the small black box in the lower right corner of the item prompt).
The item is edited by double-clicking on the control.  Then the dialog box shown in
Figure 4.20 appears.   
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Figure 4.20
Numeric  Anatomy

Figure 4.21
Push Button  Edit Dialog

The fields in the Push Button Edit  Dialog are the same as in the Checkbox Edit
Dialog with a one exception (explained below).  For further information on the fields
which are similar, see the discussion on the Checkbox Edit Dialog.

Defaults This  is  the  recommended  value  currently  displayed.    The
Defaults push button is a toggle.  Click once on the button to turn
Defaults  on,  and click  again  to  turn  Defaults  off.   The  Off/On
status  of  Defaults  is  shown by  the  location  of  a  dot  and  the
appearance of the push button.  When Defaults is set to Off, a dot
is  displayed  to  the  left  of  the  Off  field  and  the  push  button
appears  in  the  out  position  (as  it  is  in  Figure  4.20).   When
Defaults is set to On, the dot is displayed to the left of the On
field and the push button is shown depressed.  

Button - Radio 
For data fields where the user needs to choose one item from a series of options, a
radio button cluster is used.   Radio buttons are grouped in clusters.  To create a
new cluster or a new radio button (for an existing cluster), select Button - Radio
from the Input Types menu.   

The drag box will appear attached to the cursor (which appears as a hand).  If the
cursor is not over a radio cluster, the box appears large (the shape of a new cluster).
To create a new cluster, release the drag box (by clicking the mouse) outside of any
existing radio clusters.
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Figure 4.22
Dropping a Radio Cluster

If the cursor is over an existing radio cluster, the box appears small (the shape of a
new radio button).  To create a new radio button, release the drag box  inside an
existing radio cluster.

Figure 4.23
Dropping a Radio Button

Radio Cluster A radio cluster has several components not present in other types
of the data items.   Each cluster has a title and a control button.
In addition, it serves as a container for a series of radio buttons.
When  first  created,  the  cluster  contains  only  a  single  radio
button.    In order for a radio cluster to be useful, it should have
more than one radio button.

Figure 4.24
Radio Button  Cluster

Control Button Title

Radio Button
Resize Knob

Bounding Box

To edit  the cluster information,  double click on the Control  Button.  The Control
Button is only visible when the radio group is highlighted.  Select the cluster by
clicking inside the box that surrounds it.  
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Figure 4.25
Cluster Edit Dialog

Radio Group Title This  field  allows  you  to  specify  the  title  for  the  radio
cluster.  To edit the title, highlight the current title and enter your
new text.

Show Cluster Title This  checkbox  determines  whether  or  not  the  title
specified in Radio Group Title is displayed.  If the checkbox is On,
an X appears  and the title and the bounding box are displayed
for that data item.  If the checkbox is Off, no X appears in the box
and the title and bounding box are hidden.

Radio Button To edit the radio button information, double click on the control
button.   Then the dialog shown in Figure 4.25 appears.
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Figure 4.26
Cluster Edit Dialog

Prompt This is the text displayed to the right of the control.  Change the
prompt by highlighting the text currently in the box and entering
new text.

Defaults A cluster is considered to be a single piece of information.   It
contains a series of radio buttons.  Radio buttons are exclusive in
that only one can be on at a time.  When you assign a cluster to a
cell,  you are also recording which radio button is turned on at
that  time.   The  actual  value  that  is  added  to  the  cell  is  the
information stored in the Defaults box for the On radio button.
This information can be either alpha-text or numeric.

Initially On Initally On is a checkbox which indicates whether the button is on
or off when the dialog is first opened.  Since only one radio button
in a cluster can be on at any given time, only one button may be
checked as Initially On.

Location This is the current X/Y coordinates of the radio button within the
cluster.
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